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Introduction
This document provides information regarding Cisco WAN Automation Engine (Cisco WAE) Release 7.1.3
and its related patches.

Cisco WAN Automation Engine (WAE) provides the tools to create and maintain a model of the current
network through the continual monitoring and analysis of the network and the traffic demands that are placed
on it. This network model contains all relevant information about a network at a given time, including topology,
configuration, and traffic information. You can use this information as a basis for analyzing the impact on
the network due to changes in traffic demands, paths, node and link failures, network optimizations, or other
changes.

The Cisco WAE platform is an open, programmable framework that interconnects software modules,
communicates with the network, and provides APIs to interface with external applications.

This document contains the following topics:

• Release Information for Cisco WAE 7.1.3 Patch 2, on page 1

• Release Information for Cisco WAE 7.1.3 Patch 1, on page 4

• Release Information for Cisco WAE 7.1.3, on page 6

• Documentation, on page 17

• Filing a Cisco WAE Bug, on page 17

• Using the Cisco Bug Search Tool, on page 18

• Accessibility Features, on page 18

Release Information for Cisco WAE 7.1.3 Patch 2
This section provides information related to Cisco WAE Release 7.1.3 Patch 2 and contains the following
topics:

• What’s New in Cisco WAE 7.1.3 Patch 2, on page 1

• Install Cisco WAE 7.1.3 Patch 2, on page 3

• Resolved Bugs, on page 4

What’s New in Cisco WAE 7.1.3 Patch 2

The following features are new in Cisco WAE 7.1.3 Patch 2:

Layout NIMO Enhancements
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Layout NIMO is enhanced with a simpler workflow. The template information is now stored in native format
which also enables a faster execution time.

Following is the new workflow introduced in this patch:

• From the Expert Mode, navigate to /wae:networks.

• Click the plus (+) sign and enter a network model name. We recommend a unique name that contains
the source network and NIMO names. This procedure uses networkABC_layout as an example.

• Click Add.

• Click the nimo tab.

• From the Choice - nimo-type drop-down list, choose layout-nimo.

• Click layout-nimo and enter the following:

• source-network－Enter the source network for the network to use.

• storage-format－Select between yang and native formats.

• template-plan-file-path－Enter the absolute path of the template file to be used by layout nimo.

• Launch WAE Design and choose File > Open From > WAE Automation Server.

• Enter the appropriate details, choose the plan file for the network model you just created
(networkABC_layout), and click OK.

• Edit the layout.

• Click Save to > WAE Automation Server. Enter the plan file details and click OK.

• From the Expert Mode, click run-layout > Invoke run-layout.

• Navigate back to the layout-nimo network model (networkABC_layout).

• Click layouts tab.

• Click layout to confirm that the table has been populated with layout data.

WAE Design Enhancements

WAE Design now allows you to directly update the Layout NIMO template file.

Once you edit the network layout, save the plan file using the option Save to > WAE Automation Server.
Enter the plan file details and click OK.

Aggregator Configuration Options

A new aggregator configuration option cache-aggr-net is introduced in the Advanced tab (Navigation: From
the Expert Mode, navigate to /wae:wae/components/aggregators/advanced).

When this value is set to True, a copy of the aggregator plan is maintained on disk which is used to fetch data
during the get-plan requests on aggregator network, unless the file is an old version. (Database has got updated
after the last time the plan file was generated). Default value is False.

Supported Node Versions

The following table lists the supported XR versions for Cisco WAE 7.1.3 Patch 2 along with earlier supported
XR versions on WAE 7.1.3:
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Table 1: Supported Node Versions for Cisco WAE 7.1.3 Patch 2

Tested with versionProductFeature

6.6.2IOS-XRXTC (SR - PCE)

6.5.3, 6.6.2IOS-XRRest of Nodes (PCC)

Install Cisco WAE 7.1.3 Patch 2

This procedure outlines the steps necessary to upgrade to Cisco WAE 7.1.3 Patch 2:

Cisco WAE 7.1.3 Patch 2 is cumulative of the previous patches. You can directly upgrade to Cisco WAE
7.1.3 Patch 2 from Cisco WAE 7.1.3 or Cisco WAE 7.1.3 Patch 1.

Note

Procedure

Step 1 Stop WAE services using supervisor.
supervisorctl stop wae:*

Step 2 Change permission of the install file using the command:
chmod 755 wae-v7.1.3-patch2-linux.bin

Step 3 Install Cisco WAE 7.1.3 Patch 2 using the following command:
# ./wae-v7.1.3-patch2-linux.bin [-i WAE_INSTALL_DIR] [-r WAE_RUN_DIR] [-b BACKUP_DIR]

where

WAE_INSTALL_DIR is the WAE install directory path.

WAE_RUN_DIR is the run directory path.

BACKUP_DIR is the backup directory to use when creating the patch.

Step 4 Start WAE services using supervisor:
supervisorctl start wae:*

Step 5 Confirm that all WAE services are running:
supervisorctl status

Step 6 On the WAE CLI, run:
admin@wae# packages reload

After installation of the patch, use the new version of Cisco WAE Design (7.1.3-patch2) that is
available for download for all platforms.

Note

Step 7 (Optional) If license_install tool was run previously from within the WAE install directory
<WAE_INSTALL_DIR>, then run the license_install tool once again after installing this patch.
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Resolved Bugs

The following are descriptions of the resolved bugs in Cisco WAE Release 7.1.3 Patch 2:

Table 2: Resolved Bugs

DescriptionBug ID

Plan files not inserted to WAE Live server and a timeout occurs.CSCvq11492

BW-OPT fails to create SR policy.CSCvq40906

topo-nimo parses the ipv6 attributes instead of ipv4 values like link metric, SID.CSCvq41935

WAE XTC agent keeps multiple connections with XTC and one of these connections not consuming the information
sent by XTC, increasing XTC memory usage.

CSCvq86258

SNMPv3 support for inventory collection.CSCvp90288

Supervisorctl file limits need to be increased at Install time.CSCvq53205

Huawei CX600 device is not properly discovered by WAE.CSCvq54298

WAE keeps filing /tmp with sqlite tmp files.CSCvq90283

Release Information for Cisco WAE 7.1.3 Patch 1
This section provides information related to Cisco WAE Release 7.1.3 Patch 1 and contains the following
topics:

• Install Cisco WAE 7.1.3 Patch 1, on page 4

• Resolved Bugs, on page 5

• Known Limitations, on page 6

Install Cisco WAE 7.1.3 Patch 1

This procedure outlines the steps necessary to upgrade from Cisco WAE 7.1.3:

Before you begin

Make sure Cisco WAE 7.1.3 is installed before applying the patch.

Procedure

Step 1 Stop WAE services using supervisor.
supervisorctl stop wae:*

Step 2 Change permission of the install file using the command:
chmod 755 wae-v7.1.3-patch1-linux.bin

Step 3 Install Cisco WAE 7.1.3 Patch 1 using the following command:
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# ./wae-v7.1.3-patch1-linux.bin [-i WAE_INSTALL_DIR] [-r WAE_RUN_DIR] [-b BACKUP_DIR]

where

WAE_INSTALL_DIR is the WAE install directory path.

WAE_RUN_DIR is the run directory path.

BACKUP_DIR is the backup directory to use when creating the patch.

Step 4 Start WAE services using supervisor:
supervisorctl start wae:*

Step 5 Confirm that all WAE services are running:
supervisorctl status

Step 6 On the WAE CLI, run:
admin@wae# packages reload

After installation of the patch, use the new version of Cisco WAE Design (7.1.3-patch1) that is
available for download for all platforms.

Note

Step 7 (Optional) If license_install tool was run previously from within the WAE install directory
<WAE_INSTALL_DIR>, then run the license_install tool once again after installing this patch.

Resolved Bugs

The following are descriptions of the resolved bugs in Cisco WAE Release 7.1.3 Patch 1:

Table 3: Resolved Bugs

DescriptionBug ID

WMD crashes when tested using wae713 Alpha image.CSCvo81254

WAE application crashes after invoking/executing custom-network-info task.CSCvo88515

Unable to keep active connection with XTCCSCvp60520

WMD does not get traffic from traffic-poll-nimoCSCvp62803

Missmatch in traffic information data between WMD and traffic-poll-nimoCSCvp67250

Archiving in WAE times out after restarting WAE.CSCvp86817

WAE 7.1.3 does not function properly as /tmp is full of WAE tmp files.CSCvp90286

WAE server crashes while java processes continue running.CSCvo36676

WAE CLI freezes on commitCSCvp52105

Unable to discover multi-topology ISIS from Alcatel deviceCSCvn72882

WAE Design takes time to recalculate simulated traffic numbers when Multicast tables are included.CSCvp44310
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DescriptionBug ID

The traffic balance of external endpoint member is rounded off when a plan file is imported.CSCvq01121

Known Limitations

This section describes known limitations and restrictions for Cisco WAE Release 7.1.3 Patch 1:

CSCvp63150: DesignApi process memory footprints increased.

This issue can be resolved using the following workaround:

1. From the Expert Mode, navigate to /wae:wae/components/wmd:wmd and click config.

- From the network-name drop-down list, select the final network model.

- Click rpc-connection and set respawn-on-reload to true.

2. Navigate to /wae:wae/components/aggregators/aggregator <network_name> and schedule the
resync-aggregator-net action.

3. After making the changes, run the following command on WAE CLI:
admin@wae# packages reload

CSCvo36676: WAE server crashes leaving java processes running.

This issue can be resolved by upgrading Network Service Orchestrator to version 4.7.4 as part of WAE 7.1.3
patch 1.

CSCvo88515: WAE application crashes with errors "unexpected end of file" and "exception internal"
after invoking or executing the custom-network-info task.

This issue can be resolved by upgrading Network Service Orchestrator to version 4.7.4 as part of WAE 7.1.3
patch 1.

Release Information for Cisco WAE 7.1.3
This section provides information related to Cisco WAE Release 7.1.3 and contains the following topics:

• What’s New in Cisco WAE 7.1.3, on page 6

• Install Cisco WAE 7.1.3, on page 10

• Supported Node Versions, on page 12

• Resolved Bugs, on page 13

• Known Limitations, on page 14

What’s New in Cisco WAE 7.1.3

The following features are new in Cisco WAE 7.1.3.

Supervisor

WAE services have to be managed using Supervisor. Install and run Supervisor before starting WAE.

For more information, see Cisco WAE 7.1.3 Installation Guide.
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New Cisco Evolved Programmable Network Manager (Cisco EPN Manager) agent added

A new Cisco Evolved Programmable Network Manager (Cisco EPN Manager) agent is added to support the
collection of optical topology for Cisco Network Convergence System (NCS) 2000 series, Release 10.9. This
agent also receives notifications from Cisco EPN Manager version 2.2.2.1 when the status of links and circuits
change and updates the network model accordingly. When using the Expert Mode, changes to the nodes,
circuits, and so on can be seen in the agent-model tab from the following path:
wae:wae/agents/optical-agent:optical-agents/optical-agent/<epnm_agent_name>.

If optical provisioning is not done through Cisco EPN Manager, notifications are not received.Note

For more information, see "Network Model Configuration—Cisco WAE UI" chapter in the Cisco WAE 7.1.3
User Guide.

lsp-config-nimo updated

LSP collection (lsp-config-nimo) configuration is updated to integrate with NSO using the NETCONF API.

For more information, see "Network Interface Modules (NIMOs)" chapter ("Segment Routing Traffic Matrix
Collection" topic) in the Cisco WAE 7.1.3 User Guide

Segment Routing traffic matrix collection updated

Segment Routing (SR) Traffic Collection (sr-traffic-matrix-nimo) discovers SR traffic. This NIMO enables
the generation of demands between external interfaces of a network from collected telemetry data.

For more information, see:

• "Network Interface Modules (NIMOs)" chapter ("Segment Routing Traffic Matrix Collection" topic) in
the Cisco WAE 7.1.3 User Guide

• "Telemetry Configuration" chapter in the Cisco WAE 7.1.3 User Guide

DARE enhancement to process aging

The DARE aging processor is enhanced to maintain an in memory map for aged elements instead of doing
the CDB scan every time the aging scheduler runs.

For more information, see "Administration" chapter ("Configure Aging" topic) in the Cisco WAE 7.1.3 User
Guide.

XATP dependency on WMD removed

XATP functionality is moved into the two NIMOs that process data from XTC - topo-bgpls-xtc-nimo and
lsp-pcep-xtc-nimo, removing the dependency on WMD.

NIMO enhancement to support native format

The following NIMOs are enhanced to support native storage format:

• Traffic Demand NIMO

• Layout NIMO

• Inventory NIMO

• Netflow NIMO

• SRTM NIMO
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For more information, see "Network Interface Modules (NIMOs)" chapter in theCiscoWAE 7.1.3 User Guide.

Multicast NIMO

Multicast NIMO collects multicast flow data from a given network. It is a collection of the following NIMOs:

• snmp-find-multicast-nimo—Collects multicast data for multicast flows using SNMP.

• snmp-poll-multicast-nimo—Collects traffic data rate for multicast flows using SNMP.

• login-find-multicast-nimo—Logs in to router to fetch or parse multicast flow data.

• login-poll-multicast-nimo—Logs in to router to get multicast traffic rate

For more information, see "Network Interface Modules (NIMOs)" chapter in theCiscoWAE 7.1.3 User Guide.

port-cfg-parse-nimo is now renamed to topo-cfg-parse-nimo

port-cfg-parse-nimo is now renamed to topo-cfg-parse-nimo and the support to read topology from parse
configs is added.

For more information, see "Network Interface Modules (NIMOs)" chapter ("Port, LSP, SRLG, and VPN
Collection Using Configuration Parsing" topic) in the Cisco WAE 7.1.3 User Guide.

Introduction of SAgE Aggregator

A new aggregator, SAgE (Simple Aggregation Engine), is introduced to receive patches from DARE and
NIMOs depending on DARE and aggregate these changes.

For more information, see "Overview" chapter ("Cisco WAE Architecture" topic) in the Cisco WAE 7.1.3
User Guide.

Merging of Plan Files from different AS

inter-as-nimo is introduced to enable merging of plan files from different AS and resolve conflicts.

For more information, see "Network Interface Modules (NIMOs)" chapter ("Merge AS Plan Files" topic) in
the Cisco WAE 7.1.3 User Guide.

Cisco WAE UI Enhanced

Cisco WAE 7.1.3 is enahanced with various UI changes.

For more information, see "Network Model Configuration—CiscoWAE UI" chapter in the Cisco WAE 7.1.3
User Guide

Status Dashboard

The status dashboard in WAE helps to identify the processes that cause system leaks or processes that
completely use the resources. System health, WAE health, status of NIMO actions and agent actions are
captured in the dashboard.

For more information, see "Administration" chapter ("Status Dashboard" section) in the Cisco WAE 7.1.3
User Guide.

Building network model from multiple XTC

WAE 7.1.3 now supports building network model from multiple XTC.

Traffic Poller Modified

Traffic Poller tuning is enhanced for better computing.
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For more information, see "Network Interface Modules (NIMOs)" chapter ("Traffic Collection" topic) in the
Cisco WAE 7.1.3 User Guide

Option to cleanup the cache for Map display in Cisco WAE Live

Users can now cleanup Map cache based on configurable attribute in config.xml. By default, the cache for
Map display is cleaned up every 3 days. To clean up the cache more frequently, you can configure as follows:

1. Stop the Cisco WAE web server.

2. Log in to your local server and open config.xml file for editing. The default location is
/opt/cariden/etc/config/config.xml. Your location might differ if you chose a different installation
directory.

3. In the config.xml file, locate the section - <application name="Map">

4. Under <application name="Map">, do one of the following, depending on whether you are upgrading
or performing a fresh installation:

• If you are upgrading from an earlier release, add the following line:

<property name="Map.UiCacheTTL" type="String"><value> <unit></property>

• If you are performing a fresh installation, edit the existing line:

<property name="Map.UiCacheTTL " type="String"><value> <unit></property>

where

<value> is a float (a floating-point number, or a number that has a decimal place).

<unit> is either hour, or day. The unit can be singular or plural and is not case-sensitive. For example,
hour can be expressed in all of the following ways: hour, Hour, Hours, HOURS.

For example, to purge time-series data that is older than 1 hour, enter:

<property name="Map.UiCacheTTL" type="String">1 hour</property>

5. Save your changes and close the config.xml file.

6. Restart the Cisco WAE web server.

Capacity Planning Optimization for Cisco WAE Design

The Capacity Planning Optimization tool controls how L1 Circuits and their corresponding paths are created.
However, it automatically mimics the L1 Circuit characteristics of existing parallel L1 Circuits when upgrading
capacity.

To enhance the Capacity Planning Optimization tool to handle different scenarios, the following CLI options
are introduced:

• -match-existing-l1-circuits: This is a new option that is added. If set to T, when existing L3
adjacencies are upgraded (by adding parallel Port Circuits or L3 Circuits), corresponding L1 Circuits are
created based on associated L1 Circuits of parallel Port Circuits or L3 Circuits. This includes replicating
primary and secondary paths with respect to their Standby property as well as their associated Actual L1
Circuit Path Hops and L1 Circuit Path Hops. Default is F.

• -create-l1-circuits: This is a modified option. If F (default), do not create L1 circuits for new port
circuits. If T, create L1 circuits for new port circuits. If match-existing-l1-circuits is set to T, this
option is only considered for new adjacencies.
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• -primary-l1-circuit-paths: This is a modified option. If F (default), primary L1 circuit paths are
dynamically routed. If T, assign L1 circuit path hops to new primary L1 circuit paths to match the
explicitly specified routes of existing parallel L1 circuits. Ignored if -create-l1-circuits is F or if
match-existing-l1-circuits is set to T.

• -secondary-l1-circuit-paths: If F (default), do not create secondary non-standby L1 circuit paths. If
T, create secondary non-standby L1 circuit paths. Ignored if -create-l1-circuits is F. If
match-existing-l1-circuits is set to T, this option is only considered for new adjacencies.

Cisco WAE Design GUI is modified as follows:

Tools > Capacity Planning Optimization > Layer 1 tab has new options - Do not create L1 circuits, Basic
L1 Circuit Creation, and Advanced L1 Circuit Creation.

loap-plan CLI command modified

The load-plan CLI command (wae/components/load-plan) to load plan files can handle only plan files which
have the Network table as defined in schema and the Title row. However, value for the title (network name)
is optional.

Install Cisco WAE 7.1.3

This procedure outlines the steps necessary to upgrade to Cisco WAE 7.1.3.

Before you begin

• From Cisco WAE 7.1.3, the WAE services are managed using supervisor. Install and configure supervisor.
See Install and Configure Supervisor, on page 11

• Download the Cisco WAE 7.1.3 software package from Cisco Download Software site.

• Make sure Java-8 is installed on the system and JAVA_HOME environment variable is pointing to jdk-1.8.

Procedure

Step 1 Stop WAE if running.
Step 2 Change permission of the install file using the command:

chmod +x wae-linux-v7.1.3.dev-xx-yyyyyyyy.bin

Step 3 Run the installer specifying the target directory.
./wae-linux-v7.1.3.dev-xx-yyyyyyyy.bin <target-wae-dir>

Step 4 Setup environment and create a runtime directory specifying the path.
cd <wae-dir>
source waerc
wae-setup --dest <target-runtime-dir>

Step 5 You are prompted to set the Cisco WAE admin password.
WAE admin password:
Confirm password:

Step 6 After installing and setting up wae (i.e. after running wae-setup), add WAE config to supervisor and update
supervisor
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sudo ln -sf <WAE_RUN_DIR>/wae.ini /etc/supervisord.d/
supervisorctl update

Execute this step only after supervisor is installed and configured.Note

Step 7 Start WAE process
supervisorctl start wae:*
wae:zookeeper: started
wae:waectl: started
wae:kafka: started
wae:wae-monitor: started

Step 8 Check status of WAE process
supervisorctl status
wae:kafka RUNNING pid 1540, uptime 28 days, 14:03:40
wae:logrotate RUNNING pid 1178, uptime 28 days, 15:10:11
wae:wae-monitor RUNNING pid 11520, uptime 0:00:12
wae:waectl RUNNING pid 1177, uptime 28 days, 15:10:11
wae:zookeeper RUNNING pid 1736, uptime 28 days, 14:03:39

To stop all WAE process, use the command:
supervisorctl stop wae:*

Note

Install and Configure Supervisor

Install and configure supervisor before installing WAE.

The following configuration steps work only when supervisor is installed using yum. If supervisor is installed
using any other method, it has to be configured to run supervisorctl as a non root user.

Note

Procedure

Step 1 Install supervisor and verify.
sudo yum install -y epel-release
sudo yum install -y supervisor
supervisord -version
3.1.4

Step 2 Create directories with write permissions for the OS user running WAE.
sudo mkdir -p /opt/supervisor/run
sudo mkdir -p /opt/supervisor/log
sudo chown -R [USER-NAME]:[GROUP-NAME] /opt/supervisor

Step 3 Update supervisor configuration to not run as a root user.

Point the pid file to /opt/supervisor/run/supervisor.pid and user as the OS user running WAE.

Open /etc/supervisord.conf as root and edit.
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1. In the [unix_http_server] section, change ;file=/var/run/supervisor/supervisor.sock to
file=/opt/supervisor/run/supervisor.sock.

2. In the [supervisord] section:

• Change ;logfile=/var/log/supervisor/supervisord.log to
logfile=/opt/supervisor/log/supervisord.log.

• Change ;pidfile=/var/run/supervisord.pid to pidfile=/opt/supervisor/run/supervisord.pid

• Change ;user=chrism to user=[USER-NAME]

• Change ;minfds=1024 to minfds=1000000

• Change ;minprocs=200 to minprocs=257805

3. In the [supervisorctl] section:

• Change ;serverurl=unix:///var/run/supervisor/supervisor.sock to
serverurl=unix:///opt/supervisor/run/supervisor.sock

Step 4 Start Supervisor.
sudo systemctl start supervisord
supervisorctl status all

Step 5 Enable supervisor to start during system startup.
sudo systemctl enable supervisord
sudo systemctl status supervisord

Supported Node Versions

The following table lists the supported node versions for Cisco WAE 7.1.3.

Table 4: Supported Node Versions for Cisco WAE 7.1.3

NotesTested with versionProductFeature

6.5.1IOS-XRSRTM

NED Version :
ncs-4.7.1-cisco-iosxr-7.6

6.5.1IOS-XRNetconf LSP

NED Version :
ncs-4.7.1-cisco-ios-6.7

15.3IOS-XR

NED Version:
ncs-4.7.1-juniper-junos-4.1

18.1R1.9Juniper Junos

Mx960

6.5.1IOS-XRRT Apps, Multi XTC,
Reactive polling.

10.7,10.8,10.9NCS2KMultilayer
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NotesTested with versionProductFeature

2.2.1.1EPNM

•

Resolved Bugs

The following are descriptions of the resolved bugs in Cisco WAE Release 7.1.3:

Table 5: Resolved Bugs

DescriptionBug ID

Error on running topo-vpn-nimo.CSCvn17584

DARE not updating WMD model when LSP is deleted.CSCvn18171

Unable to run Plan-Archive in WAE 7.1.2.CSCvn26138

WAE 7.1.1 unable to run topo-bgpls-xtc-nimo and run-xtc-collection due to missing element error.CSCvn30441

actual_path hops are not available in DARE Aggregator.CSCvn51907

Wrong Spectral Width ID causing circuit status "unrouted" in WAE Design L1 Circuit Paths.CSCvn62567

WAE 7.1.2 fails to create new plan files.CSCvn88920

Wrong number of LSPs reported in model.CSCvo01833

Unreliable mechanism to produce statistics in a native-format file.CSCvo01841

WMD shows wrong path for LSPs (RSVP-TE), where as lsp-snmp-nimo, aggregator nimos discovers path correctly.CSCvo11400

WAE keeps filing /tmp with files.CSCvo22803

Multiple node perf data issues reported in topo-igp-nimo.CSCvo45650

DARE not processing changes, displays 'Queue full' in error.CSCvm34065

login_find_igp_db output sets nodes::AvoidTransit value to "Strict" .CSCvn00892

cfg-parse agent should ignore hash (#) in description for Huawei.CSCvn04684

Simulation of Multicast Demands is inconsistent.CSCvn06202

LSP parse config nimo or parse_config fucntion is unable to parse configs with space in hostname.CSCvn07232

Capacity Planning Opt Tool Not Creating L1 Circuits in Some CasesCSCvn12341

WAE 7.1.2 Site lat/long values are missing in DARE.CSCvn21122

Capacity Optimization Planning does not copy L1 circuit hops.CSCvn22430

cfg-parse agent incorrectly parses LSP paths on Huawei devices.CSCvn26803
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DescriptionBug ID

WAE daemon crashing without notice.CSCvn28694

Optical NIMO collection not collecting Site-namesCSCvn30828

duplicate ref error thrown when node fails collection.CSCvn56924

WAE Design L1 Links table displays 'na' instead of Metric for a very short fiber span < 1 km.CSCvn66222

Executing run-snmp-traffic-poller logs Warning [20]: auth.enc not found under traffic_de-poller.log.CSCvn75156

topo-bgpls-xtc-nimo not discovering interfaces for large network (500 devices).CSCvn78097

Traffic NIMO stops inserting traffic in model.CSCvn79097

WAE live 7.1.2 peering panel from the WAE Live Settings not working.CSCvn89056

Optical NIMO fails to import circuits with user properties.CSCvn94403

WAE 7.1.2 design does not populate LAG member port descriptions collected by the topo-igp-nimo.CSCvo04221

Demand Flow uses Level 2 links during Failure simulation.CSCvo26901

Windows mate-Design client crashes when you Hover on the "Initializers" menu.CSCvo32368

WAE does see Juniper loose bypass LSP.CSCvn39867

WAE GUI has no support to pump SNMP traffic to traffic poller network.CSCvo16665

Known Limitations

This section describes known limitations and restrictions for Cisco WAE:

WAE System

License Check Failures on Newer Linux Distributions

Some newer Linux distributions use a new way (using biosdevname) of naming hardware devices, including
network interfaces. This causes some software that depends on the traditional naming (for example, eth0 ,
eth1 ) to fail on license checks.

The workaround is to append biosdevname=0 to the kernel line of the grub configuration file and reboot.
(Syntax varies among distributions.)

After reboot, you should be able to use ifconfig to verify that the NICs are named eth0 (or eth1 , ...) instead
of the biosdevname names (such as p34p1).

NIMO Consolidation

The aggregator uses DARE to consolidate NIMOs into one network model. If you update the topo-igp-nimo
node-filter configuration, or if a node goes down after running the initial DARE configuration, you must do
the following:

1. Update the topo-igp-nimo exclusion or inclusion list.
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2. Run collection on the topo-igp-nimo.

3. Run the WAE CLI tool to resync DARE with the updated NIMO node information:

wae@wae# wae components aggregators aggregator <aggregator_network_name> resync aggregator
net

WAE Collection

• LDP data collection can only be performed by executing CLI tools using the external-executable-nimo.

• NetFlow collection is not supported on Alcatel-Lucent devices.

• Due to vendor MIB limitations, WAE cannot represent QoS traffic on interfaces that have more than one
VLAN configured. If a network contains such interfaces, their queue traffic statistics are omitted from
the collection. The total traffic on these interfaces is still measured. As a result, demands for every class
of service estimated through Demand Deduction are less accurate. Estimates of traffic totals over all
classes of services, however, are not affected.

• Collection of interface egress shaping rate for Alcatel-Lucent devices does not support LAG interfaces.

• Juniper MIBs do not support P2MP LSPs.

• WAE cannot associate a GRE tunnel with the physical interface it uses to reach the tunnel destination
because the IP-Tunnel MIB lacks this information.

• For Juniper routers, the signaled standby LSP option is not available from the standard MPLS-TE MIB.
Only the active path option name is collected.

• For Cisco IOS XR routers:

• IGP topology collected through topo-igp-nimo module:

• IS-IS link-state database with TE extensions contains incorrect interface “admin-weights” (TE
metric) on Intel-based routers.

• IPv6 IS-IS link-state database does not contain IPv6 interface addresses or parallel interfaces.
This information is only available when Cisco IOS XR supports IS-IS IPv6 TE extensions.

• MAC accounting is not supported (although you can collect MAC traffic through an external NIMO).

• The lsp-snmp-nimo module does not set the Standby value in the <LSPPaths> table for signaled
backup paths or collect named affinities configured with affinity-maps.

• BGP peers:

• The topo-bgp-nimo module does not build BGP pseudo-nodes among internal ASNs.

• The topo-bgp-nimo module does not collect BGP peers under PE-CE VRFs.

• TE Extended Admin Groups (EAGs), also known as extended affinities, are only supported from Juniper
and parse_configs.

• There is no support for building port circuits for LAG members that are not within the same IGP (inter-AS
circuits).
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• It is not possible to distinguish between physically connected and unconnected LAG ports that are down
for LAG port matching.

• With segment routing, concurrent RSVP-TE and SR-TE paths are not supported on the same LSP.

WAE Multilayer Collection

• The optical plug-in is supported on Oracle JRE 1.8 but not on OpenJDK JRE. Oracle JRE 1.8 is not
packaged with Cisco WAE. You can download Oracle JRE 1.8 from Oracle’s website.

If you are using a JRE other than Oracle JRE 1.8 for other Java programs and you want to use the optical
plug-in, you must download Oracle JRE 1.8 and add the following lines to the beginning of the
<WAE_installation_directory> /packages/optical-ctc-plugin/run.sh file:

#!/bin/bash
export JAVA_HOME=<path_to_JRE_installation_directory>
export PATH=$JAVA_HOME/bin:$PATH

• Multilayer collection for Cisco devices is supported only on the following platforms:

• Cisco Network Convergence System (NCS) 2000 platforms running version 10.61, 10.7, and 10.8
for L1 devices when using the CTC optical agent. NCS 2000 platforms running version 10.9 is
supported when using the Cisco Evolved Programmable Network Manager optical agent (EPN-M
optical agent).

• Cisco Aggregation Services Routers (ASR) 9000, Cisco Carrier Routing System (CRS), and Cisco
NCS 5500 platforms running IOS-XR for L3 devices.

• Multilayer collection is limited to the collection of unprotected circuits.

• Collection of WSON and SSON circuits are supported.

• Collection of non-WSON circuits is only supported when using the EPN-M optical agent. It is not
supported when using the CTC optical agent.

• L3-L1 mapping by LMP is supported only if the controller interface name is the same as the actual L3
interface name or of the form "dwdmx/x/x/x" where the "x/x/x/x" subscript matches that of the
corresponding L3 interface.

• Central Frequency ID mapping is currently supported only for circuit paths but not for path hops.

WAE Design

• macOS Sierra 10.12 and later implements an additional security measure for applications that are not
distributed through the App Store; this includes WAE Design.

By default, WAE Design is in a quarantine state as shown by the following command on a terminal:

xattr wae_design.app

The command returns the following output for a quarantined application:

com.apple.quarantine

As a workaround, remove WAE Design from quarantine by entering the following command in the
directory where WAE Design is installed:
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xattr -r -d com.apple.quarantine wae_design.app

You can now run WAE Design from macOS Sierra 10.12 and later.

• If you are using macOS X 10.12 or later with the WAE Design GUI and the Parse Configs tool (File >
Get Plan from > Configs), add the following lines in ~/.bash_profile:

launchctl setenv JAVA_HOME `/usr/libexec/java_home -v 1.8`
export JAVA_HOME=$(/usr/libexec/java_home -v 1.8)

FlexLM License Server

You cannot run the floating license server on a setup (Linux VM or actual host) that uses bonded virtual
interfaces (that is, a setup with multiple interfaces that have the same MAC address but different IP addresses
within a VM). If the WAE Design client tries to check out a license from a setup that uses bonded virtual
interfaces, the license checkout fails with the error "No license found."

As a workaround, run the floating license server in a standard Linux VM or host.

WAE Coordinated Maintenance

Cisco WAE Coordinated Maintenance 1.3.1 supports the WAE archive only when the data source is CDB.

Documentation
To find descriptions of all related Cisco WAE documentation, see the Cisco WAE 7.1.3 Documentation
Roadmap.

We sometimes update the documentation after original publication. Therefore, you should always review the
documentation on Cisco.com for any updates.

Note

Filing a Cisco WAE Bug
While filing CDETS for Cisco WAE, make sure the following information is captured:

• WAE configuration: supervisord configuration, aggregator configuration and the nimo configuration of
concerned network and its source-network, if any.

• <run-dir>/logs/ directory

• Plan file(s) for the network(s) of concern

• <run-dir>/data/stats/ for system stability and resource usage related issues

• <run-dir>/work/dare/ for aggregation related issues.

• <run-dir>/data/networks/*.db for issues related to networks configured as ‘native’ and the
corresponding aggregator (final-network).

• CDB dump of the networks of concern for networks of ‘yang’ format (‘yang’ is the default storage-format).

• Configuration corresponding to the component of concern. Eg: WMD, archive etc.

• For collection issues, record file(s) if the nimo supports record-playback.
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• ~/.cariden/logs/ for designapid related issues.

Using the Cisco Bug Search Tool
You can use the Cisco Bug Search Tool to search for a specific bug or to search for all bugs in a release.

Procedure

Step 1 Go to the http://tools.cisco.com/bugsearch.
Step 2 Enter your registered Cisco.com username and password, and click Log In.

The Bug Search page opens.

If you do not have a Cisco.com username and password, you can http://tools.cisco.com/RPF/register/
register.do.

Note

Step 3 Use any of these options to search for bugs, and then press Enter (Return) to initiate the search:

• To search for a specific bug, enter the bug ID in the Search For field.

• To search for bugs based on specific criteria, enter search criteria, such as a problem description, a feature,
or a product name, in the Search For field.

• To search for bugs based on products, enter or select a product from the Product list. For example, if you
enter “WAE,” you get several options from which to choose.

• To search for bugs based on releases, in the Releases list select whether to search for bugs affecting a
specific release, bugs that were fixed in a specific release, or both. Then enter one or more release numbers
in the Releases field.

Step 4 When the search results are displayed, use the filter tools to narrow the results. You can filter the bugs by
status, severity, and so on.

To export the results to a spreadsheet, click Export Results to Excel.

Accessibility Features
For a list of accessibility features in Cisco WAE, visit https://www.cisco.com/c/en/us/about/accessibility/
voluntary-product-accessibility-templates.html (VPAT) website, or contact accessibility@cisco.com.

All product documents except for images, graphics, and some charts are accessible. If you would like to
receive the product documentation in audio format, braille, or large print, contact accessibility@cisco.com.
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